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To keep the taskbar visible, point and right-click on the taskbar and, from the pop-up 
menu, click Properties. The Taskbar and Start Menu Properties window opens. Click 
the box to the left of ‘Auto-hide the taskbar’ to uncheck this option 

1.5 The Taskbar 
The taskbar is a bar that appears along the bottom of the desktop. Depending on your computer 
settings, the taskbar will either remain visible all the time on the desktop or be hidden from view.  
If it is hidden move the cursor on the desktop to the bottom of the screen and the taskbar will pop up.  
 
 
 
 

 
 
 
1.5.1 Taskbar Buttons 
The taskbar contains a number of icons in the form of buttons. A button can be clicked to perform 
a specific action. Some buttons are always on the taskbar while others appear on it from time to 
time, depending on what you are working on. 
 
Think of the items on the taskbar as if they were drawers in a real desk where things can be put 
away when they are not being used.  
 
Practice:  
 Click the Start button once and then click it again.  
 Double-click the time displayed at the bottom right-hand side of the taskbar.  

The Date and Time Properties window opens, displaying a calendar and a clock along with 
other items.  

 Point and click the Close X at the top right hand corner to close the window. 
 
The taskbar in the illustration on the right shows some more  
examples of taskbar buttons. 
 
 
1.6 Cursors 
The cursor on the screen changes automatically into different shapes, depending on the action 
being performed. The cursor shape gives the user a visual indication of what is happening. 
 
 The arrow, or normal select, cursor is probably the most common. It is used to  

select objects, to click buttons and to choose options in menus and on toolbars. 
 

 The busy cursor (or hourglass) appears when the computer is engaged in an activity  
that will take a few moments to complete. You should wait until the action is  
completed and the pointer resumes its original shape. 
 

 In some windows, a question mark button appears beside the Close X button on  
the top right of the box. When you click this button and then point to an object or  
menu, the cursor changes into the help cursor and a pop-up explanation, in a  
box, is displayed. 

 
 
1.7 Turning Off the Computer 
To turn off the computer do the following: 
 Left-click (click with the left mouse button) the Start button.  
 Move the cursor to the Shut Down button.  
 Left-click the button. 

The computer will take a few moments to shut down.  

note 
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2.1 The Keyboard  
The keyboard and the mouse are the main ‘controls’ for interacting with your computer, i.e. for 
instructing the computer to do something for you, such as, ‘go online’ to browse the internet, 
typing a letter, looking at photos from a digital camera.  
 
The keyboard is referred to as a QWERTY keyboard – taken from the layout of the first row of 
letters. The keys for letters of the alphabet are arranged in the centre of the main keys on three 
rows. Above these is a row of keys for numbers. Various other character/symbol keys are 
arranged around the letter keys, though some are included on the number keys. 
 
Most computer keyboards have an additional numeric keypad to the far right of the standard keys. 
There is also an extra row of keys at the top, called Function keys, which are used by some 
programs or applications. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In addition, there are some extra keys that are frequently used in computer work, mostly located 
around the edges of the character keys. 
 

Caps Lock key Backspace key  
 

Shift key 
 

Enter key  

 

Control key   

 
 
2.2 Basic Typing Skills  
To understand how the keys work, practise and repeat the short keyboard exercise below using a 
program called WordPad – a small application, for creating documents. 
 
To open WordPad, do the following: 

Section 2  The Keyboard

Control 
key 

W Additional 
Numeric 
keypad 

Function keys 

Character keys 

Shift key 

Space Bar Enter key Backspace key 

Caps  
Lock key 
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You can also select the Zoom buttons on the Status Bar. Use the Zoom Out button to 
reduce the view. Select the Zoom In button to enlarge the view. Alternatively, drag the 
Slider towards the Zoom Out or Zoom In buttons to decrease/increase the view: 
 
 
 
 

  Zoom to open the Zoom window. 
 100% to zoom the window to full size. 
 One Page to see one page at a time (in reduced view). 
 Two Pages to see two pages at a time (side by side). 
 Page Width so that the width of the page matches the  

width of the window. 
 Click the Zoom button. 

The Zoom window opens. 
 Select an option button to change the zoom  

percentage or change the amount or width of  
pages viewed or use the scroll wheels to  
increase or decrease the percentage in the  
Percent box. 

 Click OK. 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
1.2.4 Minimising and Restoring the Ribbon  
The ribbon can be minimised and then restored if required.  
 
To minimise and restore the ribbon, do the following; 
 
Minimising the Ribbon 
  Right-click the ribbon bar. 
 Select Minimize the Ribbon. 

The ribbon is hidden. 
 

  
 

 
 
 
Restoring the Ribbon 
 Right-click the bar containing the tabs. 

Select a Zoom to option
button or select Custom

and enter a percentage by
which to increase or

decrease the magnification

Click Minimize the Ribbon  

 

note 

Zoom out Zoom in  
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 Click Minimize the Ribbon (note how a tick is displayed beside the menu command to 
indicate that it is active). 

 
 
 

 

 
 

Practice Sequence  

1 Open Word and create a new document.  

2 Save this document as sale in the default document format in a default 
folder location that you specify. 

 

3 Save another copy of the document in Text format with the filename 
saleTXT. 

 

4 Reopen sale and practise switching between the two documents.  

5 Zoom the sale document to 80% and save.   

6 Close both documents.  

7 Use the Help function to find information on saving a document as a 
template. 

 

8 Open the sale document and save in template format (ensure that it saves 
in the correct drive/folder).  

 

9 Close the template file.  

10 Open a new document and save with the name version in Word 97-2003 
format. 

 

11 Close all documents and exit Word.  

 

Click Minimize the
Ribbon again to 

restore the ribbon 
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You can also select the Zoom buttons on the Status Bar. Use the Zoom Out button to 
reduce the view. Select the Zoom In button to enlarge the view. Alternatively, drag the 
Slider towards the Zoom Out or Zoom In buttons to decrease/increase the view: 
 
 
 
 

  Zoom to open the Zoom window. 
 100% to zoom the window to full size. 
 One Page to see one page at a time (in reduced view). 
 Two Pages to see two pages at a time (side by side). 
 Page Width so that the width of the page matches the  

width of the window. 
 Click the Zoom button. 

The Zoom window opens. 
 Select an option button to change the zoom  

percentage or change the amount or width of  
pages viewed or use the scroll wheels to  
increase or decrease the percentage in the  
Percent box. 

 Click OK. 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
1.2.4 Minimising and Restoring the Ribbon  
The ribbon can be minimised and then restored if required.  
 
To minimise and restore the ribbon, do the following; 
 
Minimising the Ribbon 
  Right-click the ribbon bar. 
 Select Minimize the Ribbon. 

The ribbon is hidden. 
 

  
 

 
 
 
Restoring the Ribbon 
 Right-click the bar containing the tabs. 

Select a Zoom to option
button or select Custom

and enter a percentage by
which to increase or

decrease the magnification

Click Minimize the Ribbon  

 

note 

Zoom out Zoom in  
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 Click Minimize the Ribbon (note how a tick is displayed beside the menu command to 
indicate that it is active). 

 
 
 

 

 
 

Practice Sequence  

1 Open Word and create a new document.  

2 Save this document as sale in the default document format in a default 
folder location that you specify. 

 

3 Save another copy of the document in Text format with the filename 
saleTXT. 

 

4 Reopen sale and practise switching between the two documents.  

5 Zoom the sale document to 80% and save.   

6 Close both documents.  

7 Use the Help function to find information on saving a document as a 
template. 

 

8 Open the sale document and save in template format (ensure that it saves 
in the correct drive/folder).  

 

9 Close the template file.  

10 Open a new document and save with the name version in Word 97-2003 
format. 

 

11 Close all documents and exit Word.  

 

Click Minimize the
Ribbon again to 

restore the ribbon 
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Overtyping 
 Press the Insert key on the keyboard. 
 Position the cursor where the text should start and start typing. 

Note how existing text is overwritten with the newly inserted text. 
 To turn Overtype off, press the Insert key again. 
 
Deleting Text 
 Position the insertion point in the correct place within the text and then click to position the 

cursor. 
 Press the Delete key on the keyboard to delete characters to the right of the cursor position or 

press Backspace to delete characters to the left of the cursor position. 
 Hold down the CTRL key and press Delete/Backspace to delete whole words instead of 

characters. 
 To delete blocks of text, first select the text and then press the Delete key. 
 
2.2.4 Searching Text  
Finding information in a document can be time consuming if it is a lengthy document containing 
lots of data. Using the Search command facilitates the process as it will find specific information 
throughout the document in one action.  
 
 To search for information, do the following: 
 On the Home tab, click the Find arrow in the Editing group (or press CTRL + F to open the 

Find window). Select Advanced Find. 
The Find window opens. 

 Enter the search word or phrase into the Find what: box. 
 

  
  

 
 
 
 
 

 
 
 
 
 

 Select the More>> button to refine the search further. 
 In this section of the Find window, you can do the following: 

 Match case (to ensure that the search word matches the case, e.g. upper/lower case, typed 
in the Find what box). 

 Find whole words only (to ensure that only whole words are found, e.g. the word note is 
found but not banknote, noteworthy, endnote, footnote, etc.). 

 Use wildcards (to stand in place of characters if you don’t know the full word, e.g. n??e will 
find donate, volunteer and note). 

 Sounds like (to find words that sound similar (e.g. nite will find note, night and neat). 
 Find all word forms. 

 Press Find Next to find each occurrence of the search word(s) in the document. 

Enter the search word(s) 

Click Find In to find occurrences of the search word
in the main document, headers/footers or text boxes

Click Find Next to move through 
each occurrence of the search word 

Click More>>
to refine the 

search further
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 When the Find facility has finished searching for all  

occurrences of the search word, a confirmation window opens. 
 Click OK. 
 Click Cancel to close the Find window. 

 
2.2.5 Replacing Text  
It can be time consuming to replace each occurrence of an existing word or phrase throughout a 
document with another word/phrase. If the word to be replaced appears many times, it is easier to 
use the Replace command to change the existing word throughout the document.  
 
To replace words, do the following: 
 On the Home tab, click the Replace command from the Editing group (or press CTRL + H to 

open the Replace window).  
The Replace window opens.  

 Enter the search word or phrase into the Find what box. 
 Enter the replacement word in the Replace with box. 
 
 
 
 
 
 
 
 
 
 
 
 Select the More>> button to refine the search further. 
 In this section of the Find & Replace window, you can do the following: 

 Match case (to ensure that the search word matches the case, e.g. upper/lower case, typed 
in the Find what: box). 

 Find whole words only (to ensure that only whole words are found, e.g. the word note is 
found but not banknote, noteworthy, endnote, footnote, etc.). 

 Use wildcards (to stand in place of characters if you don’t know the full word, e.g. n??e will 
find donate, volunteer and note). 

 Sounds like (to find words that sound similar (e.g. nite will find note, night and neat). 
 Find all word forms. 

 Press Find Next to find the first occurrence of the search word(s) and then press Replace or 
select Replace All to replace all occurrences of the search word(s) with the replacement word 

 
 
 

 

Refine the search by
matching the case or
finding whole words

only, etc.

Enter the search
word(s) in the Find

what box

Click Replace All to replace all 
occurrences of the search word

Click Find Next and then Replace 
to find and replace each 
occurrence of the search word  

Enter the replacement
word(s) in the

Replace with box

Click More>> to refine 
the search further.

Refine the search by
matching the case or finding

whole words only, etc.
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You can also copy, cut and paste text within and between documents by right clicking and 
selecting the Cut, Copy, Paste commands from the shortcut menu or by using the Drag and 
Drop method. The latter method uses the mouse to copy or move text to a different 
destination within the same document.  
 
To move text, select the text to be moved, hold down the mouse button and drag to the new 
destination (or hold down the CTRL key whilst dragging to copy the text to the new 
destination). 

 When Replace All is selected, a confirmation window opens informing you of the number of 
replacements that have been made. 

 Click OK. 
 Click Cancel to close the Replace window. 
 
2.2.6 Copying and Moving Text  
Text can be moved within the same document or between open documents.  
 
To copy and move text, do the following: 
 
Within a Document 
 To copy text within the same document, select the text and then, from the Home tab, select 

the Copy button from the Clipboard group (or press CTRL + C). 
 Select a destination position within the document and then click the Paste  

button (or press CTRL + V). 
 The duplicated text will appear in the new position. 
 To move text, follow the procedure above but click the Cut button (scissors) from the 

Clipboard group at Step 1 (or press CTRL + X). 
 
Between Documents 
 Open the required document files. Both files will be displayed as tabs on the taskbar at the 

bottom of the screen. 
 Ensure that the document containing the text to be copied, is the active document. 
 To copy text, select the text and then, from the Home tab, select the Copy button from the 

Clipboard group (or press CTRL + C). 
 Click the other document on the taskbar or select the View tab and Switch Windows.  
 Choose the other document from the list and ensure that the correct document is displayed. 
 Position the mouse where you want the copied text to be placed. 
 From the Home tab, in the Clipboard group, click the Paste button (or press CTRL + V). 
 The text will be duplicated in the selected position within the document. 
 To move text to another document, repeat the above procedure but click the Cut button at 

Step 3 (or press CTRL + X). 
 

 
 
 
 
 
 
 
2.2.8 Undoing and Redoing  
If a mistake is made when entering, editing or deleting text, it can be corrected by using the undo 
button. To redo the action, the redo button is used.  
 
To use undo and redo, do the following: 
 To undo an action, click the Undo button from the Quick Access Toolbar.  

Alternatively, press CTRL + Z to undo. 
 

Redo 

note 

Arrow 

Undo
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The Redo button displays as a repeat button, until the Undo button is utilised. When 
the Undo button is used, the Redo button becomes active. 

 
 
 

To redo an action, click the Redo button from the Quick Access Toolbar.  
Alternatively, press CTRL + Y to redo. 

 To see a list of actions, click the arrow between the buttons and select an action from the list. 
Any actions that exist before the selected action will also be undone. 
 
 
 
 
 
 
 
 

 
 
 

 
 
Practice Sequence  

1 Open Word and the document called sale.  

2 Display the non-printing marks in the document (you should see where 
spaces and paragraphs have been created). 

 

3 Hide the non-printing marks.  

4 Select the word Jumble.  

5 Remove the selection and select the final paragraph.  

6 Remove the selection.  

7 Select the whole document.  

8 Remove the selection. 
 
 

9 Edit the paragraph starting If you wish to volunteer to man one of the 
stalls so that it reads If you wish to volunteer to help on one of the stalls 

 

10 Change the name Mary to Deirdre.  

11 Using the search and replace facility, replace the word note with the word 
remember (there should be two replacements). 

 

12 
Move the text starting If you have any of the above items to donate… so 
that it displays after the telephone number (ensure there is a clear line space 
between the paragraphs). 

 

13 Copy the text starting Stalls and ending Books into a new document.  

14 Save this document as stalls and close.  

15 Save and close the sale document.  

The previous four 
actions (highlighted) 
will be undone from 
this list 

note 

The Redo button 
displays as the Repeat 
button until the Undo 
command is used 

Select the Undo arrow
to see a list of actions



4

Module 4  Spreadsheet Learn Office 2007 

214    Unauthorised Photocopying is Unlawful 

1.2 Enhancing Productivity 
Productivity can be increased by setting user preferences, such as adding a user name and/or creating 
a default folder from which to open and in which to save all spreadsheets. Using the Help facility can 
also aid productivity by providing tips and advice on how to use the program effectively. 
 
 
 
 
 
 
 

 
1.2.1 Setting User Preferences  
User preferences refer to the user name and the default location from where opened files are saved 
to. These can be changed as appropriate so that the user name is different or so that files can be 
opened or saved in another location.  
 
To set user preferences, do the following: 
 
User Name 
 Select the File menu. 
 Select Options. 
 Select the General command. 
 In the Personalize your copy of Microsoft Office, position the cursor in the User name box 

and delete the current user name.  
 Enter the new user name. 
 Click OK. 

 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter or edit the User name 

In this section, you will learn about the following: 

 Setting user preferences. 

 Using available Help functions. 

 Using magnification/zoom tools. 

 Restoring and minimising the ribbon. 

Learn Office 2007  Module 4  Spreadsheets 
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Default File Location 
 Select the File menu. 
 Select Options. 
 Select the Save tab. 
 In the Default File Location box, enter the required file location from where files will be 

opened from and saved to. 
 Click OK. 
 
  
 
 
 
 
 
 
 
 
1.2.2 Using the Help Function  
The Help function is available to give advice and help on aspects of the software that you are using. 
This is useful when you are trying to perform an action and don’t know how to proceed further. 
Just ask the Help function a specific question and then select a relevant topic for the answer. 
 
To use the Help function, do the following: 
 Select the Help button or press the F1 key.  

The Excel Help window opens. 
 Select a link to a relevant topic. 

A further set of links will appear that correspond with the selected topic.  
 Select a relevant link to refine your search. 
 Read the information on the chosen topic.  
 Use the Back button to go back a step or the Home button to return to the first  

window of Excel Help. 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Select Print to print a copy of the topic information. 
 

Enter the file
location

Browse
help and
select a

link

Click a topic to 
read the 
information on 
the chosen topic 
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1.1.11 Podcasts  
The term podcast is an acronym for Portable On-Demand Broadcast. Podcasting is an extension 
of the RSS concept (see Section 1.1.10), where content in any type of file, often music or video, 
can be subscribed to and automatically downloaded.  
 
In a typical scenario, the following happens: 
 Media content, such as episodes of a television show, are made accessible from the internet. 

Their location is published in a special file called a feed which is linked to by a URL. 
 Users subscribe to the feed on their computer using a specialised feed reader called a 

podcast client or, sometimes, podcatcher. 
 The podcast client software takes care of automatically downloading new episodes, files etc. 

as they become available. 
 Users transfer these media files to their portable device for accessing later. Usually, the 

podcast client software performs this download automatically. 
 
The illustration on the  
right shows the Juice  
application with  
some subscribed  
feeds. 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.2  Security Considerations 
 
1.2.1 Usernames and Passwords  
Almost any network, from a home network, to an office or educational establishment network, to 
the internet itself will require a username and password to gain access. The use of password 
security makes it possible to restrict access to authorised entities, and also makes it possible to 
track user activity. In corporate or educational environments, usernames and passwords are 
generally issued by IT departments and users are allowed to change their passwords but not their 
usernames. 
  
It makes sense to choose a strong password,  
containing a lengthy mixture of upper and  
lower case letters, numbers and non-alphabetic  
characters, such as underscores. Many networks  
will now actively enforce the choosing of strong  
passwords and require that users change them on  
a regular basis. 
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The URL begins with https:// rather than the normal http://. This  
indicates that the secure version of the HTTP protocol is being used.  

The Firefox browser will display a padlock icon in the bottom right of the window, and 
show the page URL in yellow in the address bar along with another lock icon.  
 

1.2.2 Secure Websites  
Buying something online with a credit card or banking online involves using a secure website. 
These sites employ encryption (see Section 1.2.4) to protect the information being transferred.  
Web browsers will indicate that a secure section of a website is being viewed.  
 
Internet Explorer shows a padlock icon to the right of the URL. 
 
 
 
 
 
 
 
 
Not all parts of a website will be secure. For example, on shopping sites the sections where 
products are selected are normally unsecured and secure pages only appear at the checkout 
section, where personal information must be entered. 
 
 
 
 
 
 
 
 
 
1.2.3 Digital Certificates  
When goods are being bought on the internet or when confidential information is being 
exchanged, there is a need to establish that agencies are authentic and the transfer of data is 
secure. Digital certificates verify that users are who they claim to be. Digital certificates offer the 
additional assurance that information sent across the internet between parties is encrypted and that 
only the authentic person, company or authority has the appropriate mechanism to decode or 
access the information.  
 
Typically, users will register with an organisation that issues digital certificates. This registration 
usually requires the checking of confidential information, e.g. credit card numbers and companies, 
to confirm identity. Companies conducting business across the internet will also register in a 
similar manner. The certifying authority then facilitates the secure communication between users 
and the recipient when, for example, a hotel booking is being paid for online. 
 
1.2.4 Encryption  
Encrypting files ensure that they cannot be accessed or utilised except by the person for whom the 
communication is intended. If there is any attempt to intercept a file as it is being transferred 
across the internet, the encryption offers a high level of security. Encryption is extensively used to 
protect information such as credit card numbers and sensitive information such as personal data or 
company secrets.  
 
1.2.5  Malware  
The term malware is used to describe a range of unsolicited and usually malicious software 
programs. They transfer between computers across networks and the internet using various 
methods – for example from malicious websites and e-mail attachments – by infecting program 
files or by exploiting security weaknesses in operating systems. Some actively destroy data, some 
steal passwords and private information, and some remain dormant until they are activated to use 
the host computer as part of a huge attack on a corporate or government network.  

note 

note 
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It is not normally necessary to enter the http:// part, or even the www. Entering just 
digg.com in the example above would still connect to the website – and save some typing. 

To access a website using its URL, do the following: 
 Enter the URL in the browser address bar (located at the top of the browser window). 
 Press Enter. 

Alternatively, click the green arrow to navigate to that website.   
 
 
 
 
 
 
 
The address bar always displays the URL of the page being viewed. It will change to reflect a 
change to a new website during browsing. 
 
1.5.2 Accessing Previously Visited URLs  
Internet Explorer keeps a history of the locations visited as the browser is used (see Section 
1.4.4). This list can be accessed by using the Forward and Backward buttons (see Section 1.5.4) 
or by clicking the downward arrow to the right of the area where the URL is entered.  
 
Individual URLs in the drop-down list can be clicked to revisit them. Only URLs that were 
manually typed into the Address Bar are available here – any visited by clicking on hyperlinks  
are not. 
 
 
 
 
 
 
 
 
 
The browsing history can also be permanently displayed in a History panel to the left of the 
Internet Explorer window.  
 
To display the browsing history, do the following: 
 Start Internet Explorer. 
 Click the Favorites button to the left of the Command bar. 

The Favorites Center opens to the left of the Internet Explorer window. 
 Click the History tab to change to history view. 

Select a time limit (e.g. Today) to see previously viewed websites. 
The URLs of previously visited websites can 
be accessed. 

 Clicking the Pin button will cause the  
Favorites Center to be permanently  
locked in place. 

 
 
 
 
 
 
 
 
 
 

note 

Pin button 

Click a time limit or view by a specific date 
A history of websites 
viewed Today 
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1.5.3 Activating a Hyperlink  
The use of hyperlinks is one of the things that make the internet revolutionary. These enable 
users to move instantly to new pages of information by clicking on special areas in the pages they 
are currently viewing. This, coupled with the ability to open links in tabs (see Section 1.3.2), 
means an experienced user can browse a huge amount of information very quickly. 
 
Hyperlinks tend to come in two forms.  
 
In a text link the text is underlined in a different  
colour to the surrounding text, and the cursor  
changes to a pointing finger icon when moved  
over it. 
 
Images can also be used as links, and the  
cursor will change in the same way when  
moved over them. 
 
 
 
 
Single-clicking a hyperlink will navigate to the linked location and display the contents, whether 
that location is somewhere else on the same page, on a different page on the current website or on 
a different website altogether. The linked location can be displayed either in the current browser 
window or in a new browser window or a new tab (see Section 1.3.2).  
 
1.5.4 Navigating Backwards and Forwards  
In addition to hyperlinks, it is possible to navigate through web pages using the Forward and 
Backward buttons on the Navigation bar.  
 
 
 
 
 The arrow pointing left is the Backward button – it goes back to the page that was being 

viewed before the current one. If the current page was the first to be viewed, this button will be 
greyed out. 

 The arrow pointing right is the Forward button. If the Backward button has been used to find 
previous pages, clicking this button will take the user forward again, through the chain of 
pages that have been viewed.  

 
In addition, the Backward and Forward buttons both  
have smaller arrows to the right side. Clicking these  
arrows will display a menu showing the list of  
visited locations, enabling one to be clicked on. 
 
 
 
 
 
 
 
 
 
1.5.5 Navigating to the Home Page  
The home page can be returned to at any time by clicking the home page icon  
on the Command bar. 
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1.5.6 Web-Based Forms  
Web-based forms are just like real-world forms and are most often used by websites where 
information must be submitted by the user.  
 
Examples include: 
 Booking flights – items such as name, address and contact phone numbers are required. 
 Ordering groceries – name, address and a list of items must be supplied. 
 

Web forms often include a variety of controls designed for users to enter or select information. 
All of the common elements that will be encountered are included in the sample form below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The Text Box enables any text to be entered, for example  

a name. If a password is being entered, the textbox will  
display the * character instead of the actual letters, for  
added security. 
 

 The Drop-Down Menu allows the selection of one item  
from a list. Only the currently selected item is displayed.  
The list is ‘dropped down’ by clicking the arrow, and another  
item can then be chosen. 

 
 The List Box displays a list of items with  

multiple items being visible at the same time.  
If there are more items than will fit, a scroll bar 
will be displayed to the right of the control. Some  
list boxes allow the selection of multiple items  
by holding the CTRL key when clicking. 
 

 The Check Box is used for simple ‘yes or no’  
choices. Clicking the box will alternate between  
ticked and unticked states. 

 
 The Radio (or Option) Button presents a range of  

mutually exclusive choices. At least one must be  
selected and only one can be selected. Selecting an  
item will unselect any previously selected item. 

 
1.5.7 Submitting a Web-Based Form  
When a web-based form has been completed, it can be submitted either by clicking the Submit 
button on the web page or by pressing the Enter key on the keyboard. 

Learn Office 2010   Module 7  Web Browsing and Communication 

Unauthorised Photocopying is Unlawful     447 

In some cases, it may be necessary to complete a CAPTCHA  
before submitting a form. This is a test to verify that the form  
is being submitted by a human rather than an automated  
program and is usually a series of slightly distorted letters and  
numbers that users have to enter into a text field to verify that  
the submission is authentic. 
 
If the form is either incorrect or incomplete, there is usually a prompt to correct or complete the 
form before resubmitting it. To reset a web-based form and clear all the fields, either the Reset or 
Cancel button can be clicked on the web page. 
 

Practice Sequence  

1 Start Internet Explorer.  

2 In the Address bar, type in the address: www.becpublishing.com.  

3 Click the blue Online Practice button on the right-hand-side of the home page.  
A login box opens, which has to be completed before the website can be accessed. 

 

4 In lower case, type the word blackrock in the username field. 
 

5 In lower case, type practice in the password box.  
 

6 Click OK. The support website window opens. 
 

7 Go to the Complete a Form link in the frame to the left-hand side of the page.  
 

8 When the cursor crosses the link, it changes to a hand.  
 

9 Click the left mouse button at this point. The form window will open. 
 

10 Type fictitious information as required into the different boxes. 
 

11 Click Next to proceed to the next set of information items. 
 

12 Carry on until a confirmation window opens to indicate the form has been completed. 
 

 
 
1.6 Using Bookmarks 
 
1.6.1 Adding Bookmarks (Favorites)  
It is convenient to store frequently used URLs so that they do not have to be remembered. This is 
achieved by creating a favourite. 
 
To create a favourite, do the following: 
 Browse the website that will be added to the favorites list. 
 Click the Favorites button and then select Add to Favorites. 
 

The Add a Favorite window opens.  
 
The Name will have been filled in  
automatically with the name of the website,  
but this can be changed if needed.  

 Click Add. 
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1.5.6 Web-Based Forms  
Web-based forms are just like real-world forms and are most often used by websites where 
information must be submitted by the user.  
 
Examples include: 
 Booking flights – items such as name, address and contact phone numbers are required. 
 Ordering groceries – name, address and a list of items must be supplied. 
 

Web forms often include a variety of controls designed for users to enter or select information. 
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 The Text Box enables any text to be entered, for example  

a name. If a password is being entered, the textbox will  
display the * character instead of the actual letters, for  
added security. 
 

 The Drop-Down Menu allows the selection of one item  
from a list. Only the currently selected item is displayed.  
The list is ‘dropped down’ by clicking the arrow, and another  
item can then be chosen. 

 
 The List Box displays a list of items with  

multiple items being visible at the same time.  
If there are more items than will fit, a scroll bar 
will be displayed to the right of the control. Some  
list boxes allow the selection of multiple items  
by holding the CTRL key when clicking. 
 

 The Check Box is used for simple ‘yes or no’  
choices. Clicking the box will alternate between  
ticked and unticked states. 

 
 The Radio (or Option) Button presents a range of  

mutually exclusive choices. At least one must be  
selected and only one can be selected. Selecting an  
item will unselect any previously selected item. 

 
1.5.7 Submitting a Web-Based Form  
When a web-based form has been completed, it can be submitted either by clicking the Submit 
button on the web page or by pressing the Enter key on the keyboard. 
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In some cases, it may be necessary to complete a CAPTCHA  
before submitting a form. This is a test to verify that the form  
is being submitted by a human rather than an automated  
program and is usually a series of slightly distorted letters and  
numbers that users have to enter into a text field to verify that  
the submission is authentic. 
 
If the form is either incorrect or incomplete, there is usually a prompt to correct or complete the 
form before resubmitting it. To reset a web-based form and clear all the fields, either the Reset or 
Cancel button can be clicked on the web page. 
 

Practice Sequence  

1 Start Internet Explorer.  

2 In the Address bar, type in the address: www.becpublishing.com.  

3 Click the blue Online Practice button on the right-hand-side of the home page.  
A login box opens, which has to be completed before the website can be accessed. 

 

4 In lower case, type the word blackrock in the username field. 
 

5 In lower case, type practice in the password box.  
 

6 Click OK. The support website window opens. 
 

7 Go to the Complete a Form link in the frame to the left-hand side of the page.  
 

8 When the cursor crosses the link, it changes to a hand.  
 

9 Click the left mouse button at this point. The form window will open. 
 

10 Type fictitious information as required into the different boxes. 
 

11 Click Next to proceed to the next set of information items. 
 

12 Carry on until a confirmation window opens to indicate the form has been completed. 
 

 
 
1.6 Using Bookmarks 
 
1.6.1 Adding Bookmarks (Favorites)  
It is convenient to store frequently used URLs so that they do not have to be remembered. This is 
achieved by creating a favourite. 
 
To create a favourite, do the following: 
 Browse the website that will be added to the favorites list. 
 Click the Favorites button and then select Add to Favorites. 
 

The Add a Favorite window opens.  
 
The Name will have been filled in  
automatically with the name of the website,  
but this can be changed if needed.  

 Click Add. 
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1.6.2 Displaying a Bookmark (Favorite) Web Page  
Bookmarks can be viewed in the Favorites Center in Internet Explorer.  
 
To open it, do the following: 
 Click the Favorites button. 

 
 
The Favorites Center opens.  

 Click the Favorites tab to display the Favorites list. 
 
 
 
 
1.6.3 Deleting Bookmarks (Favorites) 
To delete favorites, do the following:  
 From the Favorites Center, click the Add To Favorites arrow.  
 Select Organize Favorites from the menu that opens.  
 
 
 
 
 
 The Organize Favorites window opens. 
 
 Highlight the Favorite to be deleted by clicking it  

once. 
 Click Delete. 
 Click Close. 
 
 
 
 
 
 
 
 
 
 
 
1.6.4 Organising Bookmarks (Favorites)  
 
Creating Favorite Folders  
If favorites are always added to the main list, the list will soon become very long and unwieldy. It 
is therefore good practice to group favorites for similar types of websites into folders. 
 
To create a Favorites folder, do the following: 
 From the Favorites Center, click the Add To Favorites arrow. 
 Select Organize Favorites from the menu that opens. 

The Organize Favorites window opens. 
 Click the New Folder on the menu bar.  
 A new folder is added to the list. 
 Type a name for the new folder.  
 Press Enter. 

Click the website 
to be deleted 

Click Delete 

Click Close 
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Adding URLs to a Favorites Folder 
To add websites to a Favorites folder rather than to the main list, do the following: 
 Browse to the website to be added to the favorites folder. 
 From the Favorites Center, click the Add to Favorites button. 

 
The Add a Favorite window opens. 

 Select the correct Favorites folder from the  
Create In list.  

 Click Add. 
 
 
 
 
 

 
Deleting a Bookmark Folder 
To delete a bookmark folder, do the following: 
 From the Add to Favorites menu, select  

Organize Favorites. 
The Organize Favorites window opens. 

 Click the desired folder to select it. 
The folder is highlighted.  
All web pages contained in the folder  
are displayed beneath it. 

 Click Delete. 
 A Confirm Delete window opens. 
 Click Yes. 
 The selected folder is deleted. 
 Click Close to close the Organize  

Favorites window. 
 

2. Click New Folder 

1. Enter a name for 
the  New Folder 




